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Getting Started with

€ sincasEE

Sing & See is a tool that will help you develop the quality of
your voice by giving you precise real-time visual feedback on
your pitch and vocal timbre. The feedback shows you what
your voice is doing as you sing, helping you focus on specific
areas: your pitch, your vibrato, your loudness, or details of the
harmonics (overtones) in your voice.

The following pages will guide you through the installation of
Sing & See on your computer and help get your singing
training started.

For further details on using the software to improve your
singing, please visit our website: www.singandsee.com
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What is Sing & See?

Sing & See — visual feedback for voice training —is designed for singers and singing
teachers as a computer assisted learning tool to enhance their learning.

Sing & See enables you to accurately see what your voice is doing through a
computer display. The singer and teacher can instantly see what’s being sung —and
make sense of it in a musically relevant framework. This direct visual feedback
enhances the spoken feedback that teachers can give their students, and allows
singers to see patterns in their voices that they may otherwise not be able to
perceive.

If you are a singer, Sing & See enables you to actually see what your voice is doing so
you can analyse their performance — once while you are singing, and then again
while your singing is played back. The singing software contains sophisticated
algorithms that analyse the voice to work out what pitch is being sung. It is then
displayed on the computer screen in musically relevant displays. If you are a singer,
it will help you gain a deeper understanding of how your voice "fits" into the musical
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Above: Sing & See Pitch trace showing accuracy of the notes sung, development of
vibrato, and how the voice transitions from note to note.



Installing Sing & See
Windows 18! Setup - Sing & See Professionail P e X

You will have an installer
file that you either
downloaded or obtained
on a CD-ROM. When you
run this installer, it will
guide you through the
installation process.

Welcome to the Sing & See
Professional Setup Wizard
This will install SING & SEE v1.5.1 on your computer.

Itis recommended that you close all other applications before
continuing.

Click Next to continue, or Cancel to exit Setup.

Next > f ‘ Cancel

Note: If you have Windows 7 or Vista, you will be prompted to authorize the install
program to make changes to the computer. Click “Yes”.

Click “Next” to proceed through the installation steps. You will need to agree to the
licensing terms, and can leave the options to their defaults unless you wish to
change the location of the installed program.

The final step allows you to run Sing & See straight away. Otherwise you will find it in
your “Start” menu.




Mac

You will have downloaded an install disk, or have a CD-ROM. Either double click on
the install disk or insert the CD-ROM to open the install files in your finder.

e 00 &1 Sing & See Student 1.5.4.2

To install, simply drag the Sing & See
app to your Applications folder.

4 items, 10 MB available e

To install, drag the Sing and See icon into the Applications folder,
Note that the first time you run Sing and See there will be o delay whide the softwore is set up.

Note: On Mac OS X Mountain Lion you also need to install XQuartz -
click and run Installer XQuartz.pkg below

S ; : >
b

Applications alias

Sing & See Student.app

The first time that you run Sing & See

there may be a delay of 10-20 seconds
as the software environment is set up. _ .
You will see a message box such as the v

following appear: xQuartz.pkg Guides

{74 Sing & See Student 1.5.4.2

X| Wine

The Wine configuration in

’j [Users/william/LibraryApplication
1 Support/winefprefixesfSing and See Student
a is being updated, please wait...
Wine

On the Mac Sing & See makes use of the “Wine” package to provide a “fake”
Windows environment for the program to run in. You may therefore see both the Sing
& See and Wine icons appear in your dock as the program starts.

The Sing & See menu appears at the top of the actual Sing & See Window, rather
than the top of the screen (i.e. similar to on Windows).



Registration

The first time you run Sing & See you will be asked to register your copy. You may
skip this step if you are testing the application.

Note: Once the software is registered, the Product Key is considered “Used” and
cannot be refunded. If you are testing, click on “Run in Trial Mode”. You have
up to 30 days to test the application.

1. Enter your personal Product Key. This will have been provided to you when
you purchased the software:

o If you purchased a CD-ROM the Product Key is printed on the CD
cover slip

o If you purchased Sing & See directly from our website, the Product
Key will have been e-mailed to you, and you can access it by logging
into your Sing & See account page.

o If you obtained your copy of Sing & See from your teacher, choir or
school you should have been given a Product Key.

2. Enter your name  [§] Sing & See Registration... 58
and contact email
so that we can
notify you when B i it
we update the
software. Note
that the name you
enter is used to

Welcome to Sing & See Student v1.5.1.1.

Currently you have not registered your product.

K Please enter registration details below to activate
personalise your
installation of Sing Your Name: [
& See. | Your Email: |
For your privacy Poduct Key: |
we will not sell or
diSClOSE yOU r Run in Trial Mode | Buy Product Key Click to Register
name or email to

any 3™ parties.

3. After you click the “Register” button, the registration information is uploaded
to our registration server and the Product Key is checked for validity. A
unique activation code is then downloaded and installed on your computer,
in order to activate your copy of Sing & See.

NOTE: If your computer is not connected to the internet, you will need to get online
on another computer and download an activation code from
www.singandsee.com/register_online.html. You will need your Product Key and the
Hardware Signature from the Sing & See “About” page. You can save the new
Activation Code to a removable disk to transfer it to the computer where you have
saved Sing & See.



Setting up Sing & See on your Computer

Microphone

Plug the microphone into the microphone socket on your computer. This is almost
always marked with a small microphone symbol. If you are unsure, please consult
your computer's documentation.

USB Microphone

A USB microphone or USB headset can usually be simply plugged into your computer
and it will recognise it automatically and install the appropriate drivers.

External Audio Device

If you have an external audio device, make sure that you first install it according to
the manufacturer's instructions and test it so that you know that it is working. You
may have to restart your computer after installing a new device. When using
external devices you may have to make sure that Windows is using your external
device as its "Preferred device".

Microphone Selection

Sing & See utilises the default recording device. Usually this is the standard or USB
microphone that you plugged in. But if you have more than one microphone device
(for instance a web-cam or built-in laptop microphone) you need to check that
Windows has selected the microphone you want to use.

Windows XP 20
Open the “Sounds and Multimedia” control Sounds  Audo | Hardware |
panel. You can get to this by clicking Sound Playback

“Start”->Settings->Control, or from the \f Brefened devics:

ESSMaesto ____§J|

“Options->Audio Control Panel” menu item
. . Volume | Advanced l
in Sing & See.
Sound Recording
H n s . @  Preferied device:;
Click on the "Audio" tab and on the middle Y IE:;M%SHOW 3

of that panel there should be a pull-down

Volume I Advanced l
choice for "Sound Recording" - "Preferred

MIDI Music Playback

device:" With that you should be able to oy Pifened dvice
choose your audio device (if you have more W2 |Miciosolt GS Wavetable SW Synth =
than one installed, make sure that you vome | About |

choose the one connected to your
microphone).

V' Use only preferred devices




Windows 7/ 8
Open the “Sound” Control panel.

. . Lo Playbad(v Recording ‘Sounds l Communications
You get this either by clicking on the A , o
" N . A ” . Select a recording device below to modify its settings:

Options->Audio Properties” menu in o
Sing & See, or from the Windows \ > Fign Definition Audio Device
Control Panel — click on “Start”, then G DetauitDece
Control Panel, then “Hardware and 2 Hion Definition Audio
Sound”. ® T
a ITineI,n,»,,,,,, R

You may have more than one @® Motplugsed
Microphone device listed on the
“Recording” tab. Ensure that the one
you wish to use for recording is set as
the “Default Device”.
Note you can also choose Speakers or
Headphones from the “Playback” tab. ok || cance

Mac OS X

On the Mac, you select the audio input from the System Preferences “Sound” panel:
click on the “Input” tab and make sure that your desired microphone is selected.

Note that if you plugin a — —
normal external | (<> | [_showail | Q
microphone (i.e. not a USB

microphone) then you need

| Sound Effects = Output I Input

Select a device for sound input:

to select — e
“y s ” Ha Internal microphone Built-in
Line In” so that it is chosen e Audio lnein port
instead of the built-in one.

Soundflower (2ch)

Settings for the selected device:

You can also adjust the

Input volume: E,UJ W @.
microphone input volume , R
R Input level:
on this Preference Panel.
Output volume: ‘ W ‘))) Mute

@Show volume in menu bar




Recording Volume

Windows XP

Windows XP has a “Recording
Mixer” that you can use to
control the volume of the
microphone input.

Click on the "Recording Mixer"
button on the toolbar in Sing &
See. This should open the
"Recording Control" panel with
several sliders to control the
volume of each sound source.

Along the bottom is a row of
check-boxes which you use to

(51
Options Help
Mixer CD Audio Line In Microphone
Balance: Balance: Balance: Balance:
2 I Tt Tl R Tl
Volume: Volurme: Volume: Vohame:
[T Select [T Select [T Select v Select
Advanced I
ESS Maestro

select the particular source that you want to record from. If you are using the
microphone, make sure that the "Select" check mark is under the column labeled
"Microphone". Also, make sure that the "Volume" slider is set to around the half way

mark.

If the recording volume is too high or too low, adjust this slider. On some computers
you may also need to click on Advanced and adjust the “Microphone Boost”.

Windows 7 / 8
In Windows 7 and Vista, the

recording volume is controlled by a
slider in the Sound control panel.

First, select the microphone input
on the “Sound” control panel and

click on the “Properties” button.

This will open up a properties page

with a number of controllers.

Playback | Recording | Sounds l Communications

Select a recording device below to modify its settings:

Q Headset Microphone
) Default Device

-

> Microphone

” Microphone

Configure Set Default Propenie%.

OK H Cancel ]




On the Properties panel, click on
the tab that is labeled “Levels” Recordng | Sounds, | Communications

< . . - . -
Q Headset Microphone Properties 8

On the “Levels” tab, there is a
volume adjust slider and possibly
(depending on your computer Headset Microphone

hardware) a Microphone Boost d w 0]
slider. You can adjust these to
change the sound level.

| General | Listen | Levels | Advanced |

Have Sing&See open and
recording, then adjust the
microphone volume level so that
the Sing&See level meter reads {
about 8 at your highest loudness. ]

OK ] [ Cancel Apply




Start using Sing & See

While it is obviously possible to analyse and improve your own performance
with this program, Sing & See is best used in collaboration with a singing
teacher. Either way, analysing your voice with the program will allow you to
try different things with your voice, and develop in technique and style.

Pitch Trace Display

The Pitch Trace Display shows your pitch as a continuous blue line on a graduated
scale.

The vertical direction
indicates pitch, with the
time slider moving from
left to right. The red dot
shows the latest pitch
detected, and the blue
line trailing behind it
indicates the changes in
pitch over the last few
seconds.
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As you sing, the red dot indicates the pitch of what you are singing as you sing.
During replay mode, the red dot indicates the pitch of the sound as it is being played.
Replaying your singing will allow you to analyse your performance — your pitch and
its steadiness, and your vibrato.

The dark and white bands on the display indicate the black and white keys on the
piano. These are labelled on the left and right of the display for easy reference, with
flats indicated on the left and sharps on the right.

The range of pitch that is shown at any one time can be changed by scrolling and
zooming with the bar along the right side of the display.

To move the range up or down, point the mouse pointer to the scroll bar on the
right, click and hold down the left button, and drag the mouse pointer up or down.

If you have a mouse-wheel you can scroll the range up and down by rotating the
mouse wheel. On Mac iPads and some Windows touchpads you can use two-finger
swipe motion to scroll pitch.

To increase or decrease the pitch range displayed, click on the small magnifying glass
icons shown at the lower right corner of the screen.

With a mouse-wheel, hold <CNTRL> and rotate the mouse wheel to zoom the range
of pitch displayed.




Using the Pitch Displays

Because the pitch displays need to detect the pitch of your voice, they work best for
vowels. Consonants are generally excluded by the analysis algorithm, but can cause
the display to "jump around" if the software notices random pitches in the sound.
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* Try sustaining a single note in a pitch that is comfortable for your voice.
Watch to see whether the blue pitch trace stays within the borders of the
single note you chose to sing. This can tell you how steady your pitch control
is.

* Play the note on the piano keyboard and try singing that single note again,
and see how well your pitch relates to the core of the note. Compare the
pitch of your singing voice with the note played on the piano.

* Sing an arpeggio starting on that note, and watch the notes that you sing. Did
you reach the right notes? Were the notes steady? How smooth were the
transitions between notes?

* Observe your pitch accuracy, stability and vibrato. Check how easily you
move from one note to another.

* Talk to your singing teacher about specific exercises to help improve your
voice. Depending on your needs, your teacher will recommend different
things for you to work on. Using Sing & See will allow you to analyse your
performance and potentially could help you develop techniques faster than
normal.



Voice Spectrogram Display

The spectrogram shows a scrolling image of how the power in the voice is spread
between all the frequencies, from low frequencies at the bottom to high frequencies
at the top of the display. The display measures time from left to right, so that an
image of how the voice looks while you are singing gradually appears.

A

Each line indicates a
harmonic (also
called “overtones™)

The leading vertical line indicates time as it happens. When it reaches the right end
of the display, it scrolls right around to the left edge and starts moving across the
display again.

The frequency range of the display is from 0 (at the bottom) to 5kHz (5000 cycles per
second) at the top. The horizontal lines drawn on the display show 2kHz and 4kHz.

The brightness of the image represents how much energy appears at that frequency
in the voice sound.

You can change the colours used by means of the options in the View Menu.



Using the Spectrogram

The spectrogram display in Sing & See provides singers with a visual representation
of the harmonic structures in the voice as you sing. Spectrogram analysis separates
out the voice harmonics (termed the spectrum) and displays these as a vertical slice
at each moment in time (time moving in the horizontal direction).
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* The spectrogram can show the presence of the "singer's formant" as a bright
band of energy between the horizontal 2 and 4kHz lines (especially about
3kHz and upwards). The brightness in this middle part of the spectrum
reflects the strength of your singer’s formant. The singer’s formant is the
reason that a single operatic voice can be heard above an orchestra, as
trained opera singers often have a resonance peak around this area. The
spectrogram will allow you to evaluate your own voice in this way.

* Singing a vowel sound, you can observe the harmonics (overtones) of your
voice. The brightness of each of these will change for each vowel and may
change as you sing a vowel through a range of pitch.

* You can see vowel patterns more easily by selecting “broadband” analysis in
the Options menu.

* Breathiness in the voice is indicated by “noise” appearing between the
harmonics of the voice.

* With onsets, look for a clean start to the phonation with a clear harmonic
pattern.



Sing & See Contact Details

Contact details:

Sing & See

CantOvation Technology
PO Box 340-176
Birkenhead, Auckland 0746
NEW ZEALAND
www.singandsee.com

support@singandsee.com

Copyright © 2003-2014 Cantovation Ltd. All Rights Reserved.

Sing & See Community Pages

Share your stories of how you are using Sing & See in your voice training, report any
problems or make suggestions for improving the software:

www.singandsee.com/community




